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                                                              ABSTRACT 

Alzheimer’s Disease is one of the most leading and progressively debilitating 
neurodegenerative diseases characterized due to the accumulation of beta-amyloid plaques, 
and presence of tau tangles, and neuroinflammation. While years of research have been 
dedicated to determining what causes the disease, and ultimately, a cure, there has been little 
to no success in finding one, and new targets must be discovered. 

Receptor present on Myeloid Cells-2 (TREM2) is an important immunoreceptor that is 
mainly expressed on microglial innate immune cells, which are the first to respond to Central 
Nervous System (CNS). TREM2 was considered an important receptor that regulates 
microglial homeostasis by regulating many neuroprotective mechanisms including 
phagocytosis of Amyloid-Beta deposits, regulation of neuro-inflammatory processes, 
microglial survival/proliferation and preservation of synapses. A number of significant 
evidence both from the genetic and functional analyses indicate that failure to acquire 
function mutations or impaired TREM2 signaling pathways leads to impaired phagocytosis, 
chronic neuroinflammation, and accelerated Alzheimer's Disease (AD) progression. Contrary 
to this, it also demonstrates that stimulating TREM2 activity leads to better microglial 
neuroprotective responses, making TREM2 a promising target for enhancing its activity to 
develop disease-modifying therapies for AD via pharmacologic interventions. 

Considering the high profile interest in natural bioactive molecules as novel neurotherapeutic 
agents, the capacity of naturally occurring plant polyphenols to be potential regulators of 
TREM2 is addressed in this study. Epigallocatechin Gallate (EGCG), apigenin, curcumin and 
resveratrol are known to have important properties for eg - potent antioxidant, anti-
inflammatory properties. Also have the ability to cross the Blood Brain Barrier, and possess 
neuroprotective properties. 

In the present study, a computational molecular docking approach was used to explore the 
molecular interactions between TREM2 and these polyphenolic compounds. The target, a 
macromolecule, was obtained from the Protein Data Bank, and it was the three-dimensional 
crystal structure of TREM2 (PDB ID: 5ELI). The binding affinities, interaction profiles, and 
structural complementarities of EGCG, apigenin, curcumin, and resveratrol were 
systematically evaluated in the TREM2 binding site using molecular docking simulations. 

Based on the docking analysis, the four polyphenols showed a definite order of binding 
affinities. Apigenin showed binding affinity of −8.6 kcal/mol, and EGCG with an affinity of 
−8.5 kcal/mol, suggesting high specificity, stability, and thermodynamic favorability of their 
interactions with TREM2. The high binding energy of apigenin and EGCG implies that they 
can make multiple non-covalent interactions with the receptor, which help to stabilize the 
receptor-ligand complex. Curcumin showed moderate binding affinity (−7.1 kcal/mol), which 
is comparatively less, while resveratrol was found with the lowest binding affinity (−6.3 
kcal/mol) in comparison to the other tested compounds with TREM2. 

These superior binding affinities of apigenin and EGCG suggest that they possess a high 
potential for modulating the activity of the TREM2 receptor and, therefore, the functional 
responses of microglia that are central to the pathology of AD such as the regulation of 
inflammation and the clearance of amyloid-β. Both apigenin and EGCG could present 
promising neuroprotective therapeutic leads based on their ability to target TREM2. 

Though this in silico molecular docking study gives preliminary results, it serves as a solid 
computational groundwork and a mechanistic explanation for the further in vivo preclinical 
and in vitro binding studies of these polyphenolic candidates in microglial models and in vivo 
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studies. In summary, this study provides valuable insights into the therapeutic regulation of 
TREM2 signaling by natural polyphenols and suggests new drug development approaches 
using plant-derived polyphenols in the context of AD. 

 

The keywords used are TREM2, Alzheimer's disease, neuroinflammation, microglia, 
molecular docking, polyphenols, apigenin, EGCG, curcumin, resveratrol, amyloid-β, 
neuroprotection and in silico. 
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INTRODUCTION 

 

1.1 BACKGROUND AND OVERVIEW OF ALZHEIMER'S DISEASE 

Alzheimer's disease (AD) is considered to be one of the major public health challenges of the 
21st century. Alzheimer's is an irreversible, progressive, neurodegenerative disease in which 
the region of brain, responsible for memory, is affected, which causes irreversible loss of 
cognitive function. The disease causes memory loss, failure of comprehension, thinking and 
learning, leading to individuals being unable to carry out daily activities that require 
independence. The disease was first discovered in 1906 by a German psychiatrist, Alois 
Alzheimer. It was believed that the disease was only seen in middle aged people for decades, 
but now it is known that it affects older people, and is the most prevalent cause of age-related 
cognitive decline globally [1]. 

Al International has said that people suffering from this disease in the world is around 55 
million. Approximately 60 to zheimer's disease (AD) has turned into an epidemic throughout 
the world. In India, the Dementia India Report predicts that the dementia burden may increase 
to 5.3 million by 2050, which will significantly strain the nation's healthcare systems, patients 
and their families. 

There are several stages to the clinical presentation of Alzheimer. [13]. During the first stage 
of the disease (the pre-clinical or pre-symptomatic stage), there are changes in the brain of 
people which typically occur 10 years or more before they have symptoms. These changes 
include the appearance of amyloid-beta plaques and tau tangles. When the disease changes to 
the mild cognitive impairment (MCI) stage, the person with MCI loses memory and ability to 
think that is somewhat noticeable. In the late or end stage of dementia, patients experience 
severe memory loss, disorientation, loss of language, changes in personality and behaviour and 
complete loss of independent living abilities [1],[3]. 

Despite more than 100 years of research, Alzheimer's disease have no cure, and drugs that are 
available to date have symptomatic effect. The acetylcholinesterase inhibitors like donepezil, 
rivastigmine, galantamine and memantine approved for use against Alzheimer's disease [16] 
provide only short-term and modest improvements in cognitive symptoms. Newer amyloid-
targeting drugs (e.g., aducanumab and lecanemab) have demonstrated some efficacy at 
lowering amyloid, but it is not known if they are effective or safe in clinical practice.  

 

1.2 MOLECULAR PATHOLOGY OF ALZHEIMER'S DISEASE 

Two major pathological features have been identified in Alzheimer's: extracellular plaques has 
primarily aggregates of AB peptides and neurofibrillary tangles (NFTs) containing tau protein. 
These are the classical elements, but recent studies have uncovered the appreciation that the 
disease pathogenesis is a highly intertwined and self-sustaining process that includes 
neuroinflammation, synaptic dysfunction, mitochondrial dysfunction, oxidative stress, and 
disrupted proteostasis. 

Breakdown of Amyloid precursor protein by two enzymes, beta-secretase (BACE1) and 
gamma-secretase enzyme complexes to generate amyloid-beta peptides. In healthy brain, 
soluble Aβ monomers are rapidly cleared from the brain ,including enzymatic degradation, 
CSF drainage and receptor-mediated transcytosis across the BBB. 
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In normal biology, tau functions as a stabilising agent of the transportation machinery and 
microtubules of the axons. In the pathological condition of AD, the tau protein is 
phosphorylated abnormally, which results in the dissociation of the microtubules and finally 
leads to accumulation of the tau protein into NFTs by the formation of paired helical filaments 
[15]. In the human brain, pathological up-accumulation of the tau protein occurs in a consistent 
order: the entorhinal cortex, the hippocampus, then the limbic and neocortex. [1,2] 

Neuroinflammation has come to be recognized as a third central pathological feature of 
Alzheimer's disease, instead of being a minor epiphenomenon. Microglia are innate immune 
cells constantly patrolling the neural parenchyma. Microglia can also become activated in 
response to Aβ deposition and neuronal damage, and initiate inflammatory responses that can 
be beneficial and protective in the acute phase by promoting the clearance of amyloid and tissue 
repair. However, prolonged and chronic activation leads to a pro-inflammatory dysfunctional 
state of microglia, with the excessive production of cytokines ,reactive oxygen species (ROS) 
and reactive nitrogen species, which further contributes to disease progression [5],[6]. 

 

1.3 TREM2: A CENTRAL REGULATOR OF MICROGLIAL FUNCTION IN 
ALZHEIMER'S DISEASE 

Receptor present on Myeloid Cells-2 (TREM2) is one of the most important and promising 
targets discovered over the last ten years among the molecular pathways involved in microglial 
function in Alzheimer. TREM2 belongs to superfamily type 1 transmembrane receptor family 
and is predominantly expressed by microglial cells, as well as by peripheral myeloid cells like 
macrophages, osteoclasts and dendritic cells. [6],[7] 

Two to four-fold risk variants in the TREM2 gene were identified and in particular the missense 
variant R47H in TREM2 brought TREM2 to the forefront of genetic research of AD [18]. This 
risk size is comparable to known genetic risk factor for sporadic Alzheimer, the APOE4 allele, 
which suggests that immune signaling by microglial cells is important in sporadic disease 
[7],[8]. 

TREM2 transmits signals via the transmembrane adaptor protein, which includes an 
immunoreceptor tyrosine-based activation motif (ITAM). Activated by ligand binding to the 
extracellular immunoglobulin-like domain of TREM2, activated TREM2 recruits and activates 
Syk kinase which initiates signaling pathways. All of these pathways regulate extensive aspects 
of microglial functions, including their chemotactic movement, phagocytosis, inflammatory 
cytokine production, metabolism, survival and proliferation [7],[8],[9]. 

TREM2 plays a role in several key protective functions relevant to AD. It promotes clearance 
of amyloid-beta aggregates, apoptotic neurons and cellular debris via phagocytes and 
suppresses the propagation of amyloid-beta toxic protein aggregates. In addition, TREM2 also 
confers metabolic fitness to transcriptionally distinct microglia (DAM) that are expressed near 
amyloid and involved in phagocytosis, lipid metabolism and function of lysosomes, which is a 
proposed adaptive protective response to the deposition of Aβ. The absence of TREM2 impairs 
this DAM state, contributes to amyloid clearance and leads to ongoing, persistent, and chronic 
neuroinflammation to drive neurodegeneration [8],[9],[19]. 

For these complex protective functions, TREM2 has been a target of interest in the field of  
disease, and strategies to boost TREM2 signaling, to block the shedding of the TREM2 
ectodomain (to generate soluble sTREM2) and to stabilize the TREM2-DAP12 receptor 
complex are currently being explored. Nevertheless, small molecule modulators of TREM2, 
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especially of natural origin, are under-studied and hold great potential for computational and 
experimental drug discovery efforts [9]. 

 

1.4 NATURAL POLYPHENOLS AS NEUROPROTECTIVE AGENTS 

Natural polyphenols are a very large groups. So far more than 8000 polyphenolic compounds 
have been discovered in the plant world and most of them are flavonoids, stilbenes, phenolic 
acids, lignans, tannins, etc. The polyphenols are abundant in food and, tea and coffee, red wine 
and spices, and they have been associated with a multitude of health benefits across numerous 
epidemiological and experimental studies [3],[4],[10].  

Polyphenols have been investigated in numerous studies with regards to neurodegenerative 
diseases because of their activity on multiple pathogenic mechanisms related to Disease. These 
include antioxidant activity and induction of endogeneous antioxidant defense enzymes, anti-
inflammatory activity by modulation of signaling pathways, inhibition of Aβ aggregation and 
promotion of disaggregation of preformed fibrils, inhibition of BACE1 and gamma-secretase 
activities, inhibition of tau hyperphosphorylation, modulation of autophagy and mitophagy, 
and the protection of synaptic structure and function [3],[4],[5]. 

Epigallocatechin-3-gallate (EGCG), apigenin, curcumin and resveratrol are some of the most 
widely studied phytochemicals with neuroprotective properties in various chemical classes.. 
Apigenin is a flavone that is present in edible plants like chamomile, parsley, celery, it is a 
blood brain barrier permeable compound and regulates neuroinflammatory signaling, and is a 
neurogenic stimulator in the hippocampus [4]. The rhizome of (turmeric) has been shown to 
contain curcumin, which has a number of properties that have been shown to reduce Aβ 
aggregation, disaggregate preformed fibrils, chelate metal ions that are thought to mediate Aβ 
toxicity and attenuate neuroinflammation [4],[5].  

In spite of their promising multi-target neuroprotective activity, the clinical translation of these 
polyphenols in Alzheimer's disease has been limited by their pharmacokinetic drawbacks such 
as low aqueous solubility, low oral and inadequate blood brain barrier penetration. They do 
however have a wide variety of biological functions, and have been shown to be safe to use, 
making them attractive targets for structure-activity relationship studies and computational 
screening for novel molecular interactions with known AD targets such as TREM2 [3],[4],[10]. 

 

1.5 MOLECULAR DOCKING AS A COMPUTATIONAL DRUG DISCOVERY TOOL 

Docking algorithms proceed by systematically sampling the conformational space of a flexible 
ligand in a specified search space on the receptor, scoring the geometric and energetic fit 
between each pose of the ligand and the receptor, and ranking the poses based on the calculated 
binding affinity. The most common docking programs are AutoDock, AutoDock Vina, DOCK, 
Glide, GOLD, and FRED which use different algorithms for searching for binding sites and 
different scoring functions to determine the binding affinity. The platform used in the present 
study is AutoDock Vina, which is faster and more accurate than its predecessor AutoDock 4 
[11] and uses a gradient optimization method to determine a docking pose and a sophisticated 
empirical scoring function that considers steric, hydrophobic and hydrogen-bonding 
interactions. 

Molecular docking has several promising benefits in drug discovery for neurodegenerative 
diseases. It allows for screening of large compound libraries against a target of interest quickly 
and cost effectively and is used to prioritise the most promising candidates for experimental 
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testing, thereby saving time and resources from traditional high throughput experimental 
screening. The information it provides is also invaluable in understanding structure-activity 
relationships and hit-to-lead optimization, giving atomic-level understanding and insights into 
the key non-covalent interactions that mediate ligand-receptor recognition[11],[12]. 

In the particular field of  disease and neuroinflammation studies, molecular docking has yielded 
the potential interactions between natural compounds and known targets like 
acetylcholinesterase, BACE1, gamma-secretase, GSK-3β, HDAC, and, more recently, immune 
receptors such as TREM2. These computational investigations have shown the usefulness of 
in silico screening in the identification of polyphenols and other phytochemicals with 
favourable predicted binding characteristics, rational mechanism of action for their observed 
biological activity and the prioritisation of candidates for experimental follow-up [12],[21]. 

 

1.6 RESEARCH OBJECTIVES AND SCOPE OF THE PRESENT STUDY 

The overall goal of this dissertation is to systematically evaluate the binding properties of 
selected natural polyphenols to TREM2 in silico by molecular docking to find candidate natural 
polyphenols that may modulate TREM2 activity and thus potentially augment microglial 
mediated neuroprotection in  disease. 

Study objective: 

(i) To download and structure the three-dimensional crystal structure of TREM2 (PDB ID: 
5ELI) for molecular docking. 

(iii) To select, retrieve and prepare the three-dimensional structures of four representative 
natural polyphenols (EGCG, apigenin, curcumin and resveratrol) as candidate ligands. 

(iii) To conduct molecular docking studies on each polyphenol compound in the TREM2 using 
AutoDock Vina within PyRx screening software to obtain the binding affinities and binding 
pose of each polyphenol compound in the binding site of TREM2. 

(iv) To analyse and visualise the obtained protein-ligand complexes in BIOVIA Discovery 
Studio Visualizer to find out the important non-covalent interactions and binding residues. 

(v) To discuss the docking results in the light of the TREM2 biology and  disease pathology 
and suggest a computational rationale for selecting certain polyphenols for experimental testing 
as TREM2 modulators. 

This study is limited to computational in silico methods, namely the molecular docking and 
does not include experimental laboratory validation. The findings are to be used to develop 
mechanistic hypotheses and prioritization frameworks that will inform future in experimental 
studies. The study only involves the four polyphenols with already established neuroprotective 
and anti-neuroinflammatory effects, and the TREM2 crystal structure with PDB ID 5ELI, 
which represents the extracellular immunoglobulin-like domain of human TREM2 in a 
conformation appropriate for the docking analysis of the ligands. 
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CHAPTER 2 : LITERATURE REVIEW 

 

2.1 ALZHEIMER'S DISEASE: EPIDEMIOLOGY, ETIOLOGY, AND 
PATHOPHYSIOLOGICAL MECHANISMS 

The impact of the disease on the population is enormous and will keep increasing with the 
ageing of the global population. Worldwide, it is estimated there are approximately 55 million 
people, this figure will rise to 78 million and 139 million by 2050. The worldwide is estimated 
to be over one trillion USD dollars per year, including direct health care expenses, indirect 
costs due to informal care and lost productivity [1],[2]. 

There are two broad types of disease that is etiological. The familial, early onset type (less than 
five percent of all cases) is due to autosomal dominant mutations all of which lead to elevated 
levels of the amyloidogenic Aβ42 peptide. The sporadic and late onset type (the great majority 
of cases) is the result of complex interaction of a number of genetic susceptibility loci, as well 
as environmental factors, lifestyle and age-related biological changes [1],[2],[3],[17]. 

The neuropathological hallmark is the progressive deposition of Aβ plaques and 
neuroinflammatory tau in specific areas of the brain, including the hippocampus, entorhinal 
cortex and association cortices, causing loss of synapses and neuroinflammation and ultimately 
leading to neuronal death throughout the brain. The amyloid cascade hypothesis (Hardy and 
Higgins 1992, Hardy and Selkoe 1999) suggests that an abnormal accumulation of Aβ is the 
initial event in the pathogenesis of AD, leading to a cascade of events including tau pathology, 
synaptic dysfunction, neuroinflammation and neurodegeneration [14]. While most therapeutic 
strategies over the past 30 years have focused on the anti-Aβ approach, the lack of success of 
multiple anti-Aβ therapeutic strategies in recent clinical trials has shifted the focus to a more 
general consensus that all four factor – neuroinflammation, tau pathology, synaptic dysfunction 
and metabolic abnormalities – must be targeted [3],[5],[22]. 

And astrocytes and peripheral immune cells, the primary cells implicated in neuroinflammation 
in Alzheimer's disease are the innate immune cells, called microglia. The last ten years of 
(GWAS) have identified a remarkable number of AD risk-loci within genes that are primarily 
or entirely expressed in the microglial immune system, such as TREM2, CR1, CLU, CD33, 
INPP5D, MEF2C and many others, confirming the idea that microglial immune signaling is a 
primary driver of AD risk and progression, not a mere secondary consequence of 
neurodegeneration [5,6,7]. 

 

2.2 TREM2 IN NEURODEGENERATION: STRUCTURE, SIGNALING, AND 
DISEASE RELEVANCE 

The TREM2 gene is a glycoprotein of the immunoglobulin superfamily found on chromosome 
6p21.1. The protein contains an extracellular immunoglobulin variable (IgV) domain for 
binding to the ligand, a short stalk domain, one transmembrane (TM) domain with a critical 
Lys that binds to the negatively charged adaptor DAP12 and a short cytoplasmic tail [7],[8]. 

The structure of TREM2 has been determined by X-ray crystallography and cryo-electron 
microscopy, which has significantly aided in understanding TREM2 function. The crystal 
structure of the human TREM2 extracellular domain (PDB ID: 5ELI) shows that the structure 
is a classical IgV-fold with a conserved disulfide bond with a positively charged surface that is 
expected to bind negatively charged lipid ligands and phospholipid-associated proteins that 
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aggregate during neurodegeneration. Structural studies have revealed that the key structural 
binding surface is a hydrophobic groove surrounded by charged patches, and it is this structural 
binding surface that has been a key informational basis for computational docking studies 
[7,8,9]. 

The ligands that have been identified to date are diverse compounds that reflect the receptor's 
role in the recognition and response to cellular damage and lipid dysregulations in 
neurodegeneration. They include soluble oligomeric forms of Aβ, apolipoprotein E, clusterin, 
sulfated glycosaminoglycans, (VLDL), and phosphatidylserine and phosphatidylethanolamine 
exposed on apoptotic cell membranes [8],[9]. The diversity of these ligands suggests that 
TREM2 can sense the lipid micro-environment and lipid status of the brain parenchyma. 

The cellular changes induced by the TREM2 signaling are well documented in disease. During 
trophozoid deprivation conditions, TREM2 signaling is able to protect microglial cells from 
death by activating the PI3K-Akt-mTOR pathway and blocking apoptosis. It promotes the 
phagocytosis of microglia resulting in improved internalization and degradation of apoptotic 
neurons and Aβ aggregates in the lysosomes. It aids in the conversion of the metabolic pathway 
of the microglial cells from glycolysis to oxidation phosphorylation and fatty acid oxidation 
that is required to maintain the energy-consuming disease-associated microglial state. 
Moreover, TREM2 signaling regulates inflammatory cytokine release that normally results in 
a more anti-inflammatory microglial phenotype that prevents collateral neuronal damage 
[8],[9]. 

In contrast, loss-of-function mutations of TREM2, ectodomain shedding by the 
metalloprotease ADAM10 and a lack of engagement with ligands have all been shown to have 
a spectrum of negative effects which are variously manifested as decreased clustering of 
microglia around amyloid plaques, decreased amyloid compaction or clearance of Aβ, 
increased neuritic dystrophy around plaques, increased inflammatory signaling, and increased 
neurodegeneration. In parallel, the genetic deletion of Trem2 in mice is associated with an 
increased amyloid pathology, loss of disease-associated microglia, and impaired cognitive 
function [7],[8],[9]. 

Numerous lines of evidence support the translational relevance of TREM2 in human AD. In 
addition to the genetic risk associated with R47H, R62H, and other coding variants, soluble 
TREM2 (sTREM2) in the CSF has been shown to be a marker of microglial activation and 
disease progression, and to increase with tau pathology and be correlated with clinical 
deterioration. In a detailed systematic review of both TREM2 and sTREM2 in Alzheimer's 
disease, Zhang et al. (2025) identified that sTREM2 is a dynamic marker of microglial 
reactivity to amyloid and tau pathology and that there is a potential for TREM2 signaling 
enhancing drugs to be disease modifying drugs. Yin et al. (2024) conducted a second review, 
which again affirmed the role of TREM2 in regulating neuroinflammation, phagocytosis and 
microglial survival, and provided genetic, transcriptomic and proteomic evidence that TREM2 
is involved in AD disease progression [2]. 

 

2.3 NATURAL POLYPHENOLS IN ALZHEIMER'S DISEASE: MECHANISMS AND 
EVIDENCE 

In the past 20 years, there has been a compelling epidemiological, preclinical and, increasingly, 
clinical evidence that indicated that dietary and plant-derived polyphenols may afford to some 
extent neuroprotection against Alzheimer's disease. Some epidemiological studies have found 
inverse associations between dietary polyphenol patterns (e.g. Mediterranean and 
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Mediterranean-like diets) and cognitive decline and dementia in older individuals. These 
resulted in detailed mechanistic studies of particular polyphenolic compounds and their 
molecular targets and biological activities in AD models [3],[4],[10],[20]. 

2.3.1 Epigallocatechin-3-Gallate (EGCG) 

EGCG is the most common polyphenol in green tea, and the most studied polyphenol anti-
Alzheimer drug. C22H18O11, molecular weight 458.37 g/mol, chemically it is a flavan-3-ol 
that is esterified with gallic acid and has several catechol and galloyl hydroxyl groups 
contributing to its high antioxidant and metal-chelating properties. EGCG has been shown to 
act as a beta-sheet breaker in the secondary structure of Aβ; to disaggregate preformed Aβ 
fibrils; to chelate transition metal ions (copper, zinc, iron), which have Aβ oligomerization; and 
to inhibit the activity of BACE1 [3],[4]. 

EGCG inhibit activation of NF-κB, and reduce cyclooxygenase-2 (COX-2) expression and 
inducible nitric oxide synthase (iNOS), and suppress the production of tumor necrosis factor. 
Conducted a review on polyphenols and their neuroprotective effects, highlighting the multi-
targeted profile of EGCG: anti-amyloid, antioxidant and anti-neuro-inflammatory action [3]. 
In several studies of APP/PS1 and 3xTg-AD transgenic mouse models, dietary supplementation 
with EGCG has been found to reduce amyloid plaque burden, reduce levels of 
neuroinflammatory markers and improve cognitive deficits in behavioral paradigms [3, 4]. 

2.3.2 Apigenin 

One of the flavones found in high quantities in chamomile flowers is apigenin which is also 
found in large amounts in the flowers of parsley, celery and other edible plants. Apigenin has 
been the subject of much research in the field of  disease because of its unique pharmacokinetic 
characteristics compared to other polyphenols, such as its metabolic stability and its low 
toxicity profile [4]. 

The anti-neuroinflammatory activity of apigenin can be achieved through multiple 
mechanisms, including the modulation signaling pathways, repression of microglial activation 
markers and cytokines. A review by Özge Şahin et al. (2025) reported that apigenin has been 
shown to have neuroprotective properties in diseases, suggesting that its multi-target activity 
and anti-neuroinflammatory and anti-amyloidogenic effects render it a promising therapeutic 
agent [4]. A particular interest of apigenin is its ability to modulate microglial function and 
inflammatory signaling pathways, which makes it an interesting candidate for further studies 
as a potential TREM2 modulator. 

2.3.3 Curcumin 

Turmeric (Curcuma longa) is a spice used for centuries as a potent medicinal herb in Ayurvedic 
and Curcumin is the major polyphenolic pigment present in turmeric. Curcumin has received 
extensive preclinical studies and a few clinical trials and has been extensively studied natural 
in Alzheimer's studies [4],[5]. 

Curcumin's anti-Alzheimer mechanisms are very wide-ranging. It directly binds to and inhibits 
the aggregation of both Aβ and tau, disaggregates preformed Aβ aggregates, chelates metal 
ions, inhibits BACE1 and gamma secretase activity and activates Nrf2-mediated antioxidant 
responses, and has potent inflamation stopper and STAT3 signaling pathways. Specifically, 
Chen et al. (2025) carried out a detailed review on polyphenols, namely curcumin for AD, and 
conducted an extensive analysis of their molecular and therapeutic mechanisms, based on in 
silico data [5]. Even with these promising preclinical characteristics, the clinical translation of 
curcumin has been limited by very low aqueous solubility, low oral bioavailability and rapid 
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metabolic inactivation that has led to the development of interest in the formulation of 
curcumin into nanoparticles and the development of structural analogues that have better 
pharmacokinetic properties [4],[5]. 

2.3.4 Resveratrol 

A stilbene polyphenol, produced by a variety of plant species injury and pathogen attack, and 
is particularly abundant in the skin of red grapes, red wine, berries and peanuts. The 
involvement of resveratrol in the activation of the NAD, a central control point for cellular 
metabolism, stress response and longevity pathways, is the primary reason for the extensive 
research into its role in aging. 

In  disease models, resveratrol has neuroprotective effects, activating SIRT1, which results in 
the removal of misfolded tau and the clearance of Aβ oligomers by autophagy. It also has an 
effect on AMPK signaling, inhibits the activation of NF-κB and NLRP3 inflammasome, 
prevents mitochondrial dysfunction and oxidative stress, and regulates APP processing to 
decrease Aβ production. Zhang et al. (2021) summarized the role of polyphenols, such as 
resveratrol, as modulators of neuroinflammation and neurodegeneration in Alzheimer's disease 
and its capacity to regulate microglial activation states and inflammatory signaling networks 
[10]. For mild to moderate AD, the clinical trials with resveratrol have been found to be 
generally safe and well-tolerated, with some evidence of its effects on CSF Aβ40 levels and on 
neuroinflammatory biomarkers, however, efficacy outcomes have been inconsistent [4],[10]. 

2.4 MOLECULAR DOCKING IN NEUROPHARMACOLOGY: METHODS AND 
APPLICATIONS 

The molecular docking technique is an essential instrument in drug discovery when dealing 
with neurodegenerative diseases since it is able to identify lead compounds and to explain the 
interaction mechanism between these compounds and disease-related protein targets, in a fast 
and economical manner. The molecular docking problem can be divided into three related 
computational problems: (1) the conformational and positional search algorithm for samples; 
(2) the scoring function that evaluates and ranks samples; (3) the protein representation to 
capture conformation features relevant to the binding of the ligand [11],[12]. 

Developed at the Scripps Research Institute by Trott and Olson and published in 2010, 
AutoDock Vina is based on an iterated local search global optimizer, a gradient optimizer for 
pose refinement, and an empirical scoring function that is calibrated using experimental 
protein-ligand co-crystal structures and binding affinity data. The prediction of binding is based 
on a scoring function that combines the steric (repulsive/dispersive) and hydrophobic/hydrogen 
bonding components, and a score below 0 kcal/mol indicates that the molecule will bind better 
[11]. In this present study, the program PyRx was used as a graphical interface of AutoDock 
Vina which is a platform for 3D protein preparation, docking and analysis of docking results, 
thus significantly decreasing technical barriers to HTS-VS [11]. 

A major question is whether the molecular docking predictions are correct or not, which is 
highly dependent on the accuracy of the input protein structure, the completeness and accuracy 
of the ligand preparation, including the correct protonation state and definition of the torsions, 
and the selection of an appropriate search space (grid box) that covers the biologically relevant 
binding site sufficiently. If binding site is not well defined from the experimental data, blind 
docking over the entire protein surface (as employed here) is an unbiased approach for 
identifying the preferred binding site [11],[12]. 

1
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Once the top-ranked docked poses are obtained, it's straightforward to characterize the non-
covalent interactions between the ligand and receptor in the visualization software, such as 
BIOVIA Discovery Studio Visualizer. All these interactions contribute to binding affinity and 
selectivity in different ways, and includes conventional hydrogen bonds (with donor-acceptor 
distances below 3.5Å), pi-cation (aromatic rings with positively charged residues) interactions, 
pi-pi stacking (face-to-face and T-shaped) interactions and halogen bonds [12]. 

In the field of TREM2 and neuroinflammation research, Ulland and Colonna (2020) reviewed 
the mechanism of microglial activation and the involvement of TREM2 in Alzheimer, detailing 
TREM2's its potential as a drug target, and examining strategies to modulate TREM2 function 
in Alzheimer's disease [7]. Deczkowska comprehensively studied the physiology, pathology 
and therapeutic potential of the TREM2 signaling pathway, providing mechanistic rationale for 
targeting TREM2 in neurodegeneration [8]. Sudom et al. (2023) demonstrated that 
pharmacological modulation of TREM2 activity can influence microglial responses and 
amyloid pathology in AD mouse models, which suggests that TREM2 is a potential therapeutic 
target [9]. 

Previous computational docking performed to understand the interactions of natural 
compounds with TREM2; this is still an emerging area. Vicente-Zurdo et al. (2024) and Özge 
Şahin et al. (2025) both investigated the molecular mechanisms and in silico data for 
polyphenols as neuroprotective agents in  disease, providing insights into the role of docking 
in understanding protein-ligand interactions and predicting bioactivity [3],[4]. The current 
study is linked to the in silico use of computational methods by investigating polyphenolic 
compounds with the help of in silico methods in the context of Alzheimer's disease specifically 
[5]. These publications provide the scientific rationale and methodological precedent for the 
in-silico evaluation of natural polyphenols as TREM2 modulators which took place in this 
dissertation. 

2.5 GAP ANALYSIS AND RATIONALE FOR THE PRESENT STUDY.  

Although the pathological importance of TREM2 dysfunction in disease has been well 
established, and the neuroprotective role of polyphenolic compounds has been corroborated by 
numerous publications, polyphenolic compounds and the TREM2 protein have never been 
systematically characterized by computational docking analysis. Previous molecular docking 
investigations of polyphenols for AD have been mostly directed toward the classical enzymatic 
targets (acetylcholinesterase, BACE1, and GSK-3β), and with only a few studies targeting 
immune receptor targets (TREM2) [3],[4],[5]. 

In addition, although the genetic and functional evidence for TREM2 as a primary regulator of 
risk and progression of disease is undeniable, and several biopharmaceutical strategies to 
enhance TREM2 signaling are in the preclinical and early clinical development, the possibility 
of naturally occurring small molecules that can modulate TREM2 function remains 
unexplored. Given the multi-target neuroprotective properties, the excellent safety profiles, 
brain permeability, and anti-neuroinflammatory effects of natural polyphenols, this class of 
compounds is an interesting group of potential TREM2 modulators that should be explored 
systematically using computational tools [7],[8],[9]. 

To fill this gap, the present study marks to systematically analyze the molecular docking of 
four representative polyphenols (EGCG, apigenin, curcumin, and resveratrol) with the TREM2 
crystal structure using both binding affinity and binding pose as criteria, as well as to identify 
major interacting residues and to interpret the results TREM2 biology and disease 
pathogenesis. The results will be used to offer a mechanistic computational reason for 
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prioritizing candidate polyphenols to be further validated through experimental testing in cell-
based and animal models of Alzheimer.   
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                                                 CHAPTER 3 : METHODOLOGY 

 

Molecular docking helps to find out the binding interactions between TREM 2 and a panel of 
commonly used Natural plant-derived polyphenols for example epigallocatechin gallate 
(EGCG), apigenin, curcumin, and resveratrol to predict their potential to stabilize IL-11 
through favorable interactions. Here, we used PyRx for virtual screening of multiple excipients 
(ligands) targeting TREM 2. The following paragraphs detail the approach utilized for ligand 
selection, protein preparation, molecular docking, and validation procedures. 

3.1 PROTEIN STRUCTURE RETRIEVAL AND PREPARATION   

• The 3D structure of (TREM2) was retrieved   From the AlphaFold Protein structure Database. 
The predicted structure was produced from the AlphaFold2 deep learning model created by 
DeepMind and EMBL-EBI.  

• The prediction confidence for every residue was eliminated using the pLDDT scores 
provided. Regions with low confidence were visually checked and, if necessary, were removed 
from docking studies to maintain the reliability of interaction predictions.   

• All water molecules and heteroatoms were removed using Auto Dock Tools. Polar hydrogens 
and Gasteiger charges were assigned. The protein was stored in PDBQT format for docking. 

 

Screenshot showing loading of protein in Auto Dock 4.0 
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Fig 3.2: Screenshot showing protein after modification 

1. Download the ligand  

Visit PubChem at www.pubchem.ncbi.nlm.nih.gov.  

• 3D Structures of EGCG, Apigenin, Curcumin, Resveratrol, were fetched from PubChem 
(https://pubchem.ncbi.nim. nih.gov/in) and were converted into PDBQT format using Auto 
Dock Tools.  

• Geometry optimization and torsion tree definitions were applied to prepare flexible ligand  

2.Performing docking using pyrx  

Auto dock Vina will be the docking tool that we use. We use the Vina algorithm to dock it in 
Pyrx. Launch Pyrx GUI and followed the steps given below:  

2.1Protein Loading  

• Select "File" -> "Load Molecule" or simply click the first icon in the upper left corner. Choose 
the protein structure that you downloaded. referred to here as "TREM 2"  

• Convert pdb format of protein to pdbqt by right clicking on TREM 2 then on display and now 
select macromolecule. 
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Fig 3.3 Screenshot showing conversion of protein file pdb to pdbqt 

 

Fig 3.4 Conversion of protein file pdb to pdbqt 

 

2.2 LIGAND LOADING  

• In PyRx, click on OpenBabel and select on insert new item present on bottom right corner.  

• Now select each ligand from folder one by one and upload it. 
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Fig 3.5: Screenshot showing loading of ligands 

 

• After uploading all ligands, right click on ligand and select minimize all to decrease the 
energy. 

 

 

Fig 3.6: Screenshot showing minimization of energy of ligand 

 

• Again, right click and select convert all to AutoDock ligand (pdbqt) to convert all ligands to 
pdbqt format. 
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Fig 3.7: Screenshot showing conversion of all ligands to pdbqt 

 

3 Defining ligands and proteins  

The loaded protein and ligand are shown under the "Molecules" tab. It is now necessary to 
identify which is a ligand and which is a protein. • Right-click on the protein –> “Autodock” > 
“Make Macromolecule” to accomplish that. Perform a right-click on the ligand, select 
"Autodock," then "Make Ligand."After that, you'll see that it has automatically prepared their 
PDBQT files under the 'Autodock' page. 

 

Fig 3.9:  Screenshot showing grid box 
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4 Defining grid box 

• Now click on Vina Wizard and select start option on bottom right corner. Start selecting 
protein and ligand one by one by pressing shift and control button.  

• Click on forward. Grid box appears. Return to the 'Molecules' tab located on the right-hand 
side. Click the loaded protein's "+" symbol.  

• All of the residues in the chain will be visible to you. To choose the binding residues, right-
click on the residue and choose Atoms, Display, Label, and Atoms. The atoms will start to show 
up on the protein. Now make the appropriate adjustments to the grid box so that it contains all 
of the selected residues. The ligand does not need to be enclosed within the grid box. 

5 Running vina for docking  

• To adjust the exhaustiveness, simply enter the desired number in the box located in the left 
bottom corner. Once everything has been adjusted, press the "Forward" button.  

• Docking will begin, and the processing will be shown. The bottom panel will display the 
poses and their binding affinities after the docking process is complete. It will show all poses 
along with RMSD values. Save your file in excel sheet.  

• Now analyze the result and the one ligand which has the highest energy with negative sign is 
selected. Again, open pyrx tab and click on Auto Dock and select macromolecule and select 
the ligand with highest binding energy. Now right click and select display then all models of 
the ligands get displayed and select your desired model and save it in pdb format. 

 

 

Fig 3.10: Screenshot showing running of vina wizard 

 

6 Open Discovery Studio: -  

Start a new project in Discovery Studio.  
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7 Protein Structure Import:  

• Open Discovery Studio and import the structure of the target protein.  

• Choose your protein structure file (such as *.pdb) by using File > Open. 

 

Fig 3.10: Screenshot showing visualization of protein structure in discovery studio 

 

8 Import Docked Ligand Conformations:  

• Import the docked ligand conformations.  

• Use File > Open and select the converted ligand file (e.g., *.pdb or *.mol2). 

9 Visualize Docked Poses:  

• Display the protein and ligand together in the 3D workspace.  

• Use the View > Sequence panel to ensure the correct structures are loaded.  

• Adjust the display settings to show interactions clearly (e.g., stick or surface 
representations). 
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Fig 3.11: Screenshot showing EGCG binding with TREM 2 

10 Analyse Binding Affinities:  

• Check the binding affinities associated with each docked pose.  

• This information can be found in the PyRx log files or the output summary from PyRx.  

• Record the binding affinity scores (typically in kcal/mol) for reference.  

11 Examine Binding Interactions:  

• Use the Analyze > Receptor-Ligand Interactions tool to identify and visualize key interactions 
between the ligand and the protein.  

• Highlight hydrogen bonds, salt bridges, and π-π stacking and hydrophobic interaction 

interactions. Check for consistency with known binding sites or important residues in the  

binding pocket. 

12 Evaluate Docked Poses:  

• Compare multiple docked poses to determine if there is a consensus binding mode.  

• Use the View > Compare tool to overlay different conformations and evaluate their  

similarity.  
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CHAPTER 4 : RESULT 

 

The binding affinities (kcal/mol) between TREM 2 and various natural plant polyphenols are  

summarized in the table below: 

RESULTS 

EXCIPIENT BINDING ENERGY 
(kcal/mol) 

Apigenin -8.6 

EGCG -8.5 

Curcumin -7.1 

Resveratrol -6.3 

Table: Binding Energies of TREM2 with selected excipients 

 

 

Fig 4.1: Screenshot showing Binding Affinities 

 

These results indicate that Apigenin exhibited the strongest binding to TREM 2, closely 
followed by EGCG and Curcumin. In contrast, Resveratrol displayed weaker interactions, 
suggesting a reduced potential for stabilizing the protein.  
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Molecular docking showed that Apigenin(–8.6kcal/mol), EGCG (–8.5 kcal/mol), and had 
stronger binding affinities with TREM 2 compared to Curcumin (–7.1kcal/mol) and 
Resveratrol (–6.3 kcal/mol). Polyphenols formed multiple hydrogen bonds with key TREM 2 
residues, suggesting better surface interaction and potential stabilizing effects.  
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DOCKING OF DIFFERENT EXCIPIENTS WITH TREM 2 

 

 

Docking of TREM 2 with EGCG 

 

 

Figure 1: 2D and 3D structures of the TREM2–EGCG complex. EGCG binds with TREM2 
through a Pi–Cation bond (ARG122) and a Pi–Sigma interaction (VAL). Several hydrophobic 
interactions, including Pi–Alkyl interactions (PRO), also contribute to the stabilization of the 
complex. In addition, conventional hydrogen bonds with THR residues further support the 
stability of the complex, suggesting a good fit of EGCG within the binding pocket of 
TREM2. 
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Docking of TREM 2 with Apigenin 

 

 

Figure 2: 2D and 3D structures of the TREM2–Apigenin complex. Apigenin interacts with 
TREM2 through Pi–Cation interactions (ARG47, ARG122) and a Pi–Sigma interaction 
(VAL64). Several hydrophobic interactions, including Pi–Alkyl interactions (PRO59), also 
contribute to the stabilization of the complex. A conventional hydrogen bond with ASN 
residues further supports ligand binding, while an unfavorable acceptor acceptor interaction 
with TRP residues is also observed. These interactions suggest that Apigenin fits well within 
the binding pocket of TREM2, contributing to the overall stability of the protein–ligand 
complex. 
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Docking of TREM 2 with Curcumin 

 

 

Figure 3: 2D and 3D structures of the TREM2–Curcumin complex. Curcumin interacts with 
TREM2 through conventional hydrogen bonds (ASN residues), which contribute to stabilizing 
the ligand with binding pocket. In addition, an Amide–Pi stacked interaction (PRO) are 
observed, further supporting the stability of the complex. These interactions suggest that 
Curcumin fits well within the binding pocket of TREM2, contributing to the formation of a 
stable protein–ligand. 
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Docking of TREM 2 with Resveratrol 

 

 

Figure 4: 2D and 3D structures of the TREM2–Resveratrol complex. Resveratrol interacts with 
TREM2 through conventional hydrogen bonds (TRP and PHE residues), which help stabilize 
the ligand binding pocket. In addition, a Pi–Sigma interaction (PHE) and a Pi–Pi T-shaped 
interaction further contributes to the stabilization of the complex. A Pi–Anion interaction with 
ASP is also observed, suggesting that Resveratrol fits well within the binding pocket of TREM2 
and forms a stable protein–ligand complex. 
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DISCUSSION 

TREM2 is a key player in the current knowledge of the mechanisms underlying Disease (AD) 
pathogenesis. TREM2 is a transmembrane glycoprotein that is mainly expressed on microglia 
cells and is a key sensor of the microenvironment of the brain that orchestrates microglial' state. 
Overall, the results of this study support the hypothesis that TREM2 plays an important role in 
microglial regulation of survival, phagocytosis of amyloid-β (Aβ) and neuroinflammation. In 
literature, impaired TREM2 signaling has been described as a disruption of microglial 
activation and lower clearance of Aβ plaques causing chronic inflammation and increased 
neurodegeneration. Therefore, the activation of this receptor to promote microglial metabolic 
fitness and shift to protective phenotypes is an important therapeutic approach. 

Four natural phytochemicals namely epigallocatechin gallate (EGCG), apigenin, curcumin, and 
resveratrol were tested in the present molecular docking study for their interactions with the 
TREM2 receptor (PDB ID: 5ELI). The results from the computational analysis showed that 
Apigenin and EGCG had the binding affinities, of −8.6 kcal/mol and −8.5 kcal/mol,. These 
values indicate much stronger and more stable interactions in the receptor binding pocket for 
these compared to the Curcumin and Resveratrol (−7.1 and −6.3, respectively), both of which 
are naturally-derived antioxidants. These binding energies indicate that both Apigenin and 
EGCG are thermodynamically stable enough to interact with the V-set immunoglobulin domain 
of TREM2 in the correct way to be able to bind to the ligand and trigger immune signaling. 

These particular ligands were chosen for their well known cytoprotective, and neurorestorative 
properties. Phenolics have recently been shown to regulate neuroinflammatory mechanisms 
and to reduce the toxic effects of amyloid in diverse models of AD. These general 
neuroprotective effects are complemented by our docking results, which implicate direct 
interaction with TREM2-associated pathways as a means by which Apigenin and EGCG may 
exert its effects. This may have a beneficial effect on microglial functions that are important to 
AD pathology, such as enhancing clearance of Aβ and the control of chronic 
neuroinflammation. 

While these results are obtained by in silico computational analysis, it provides a sound basis 
for proposing a mechanistic justification for the prioritization of Apigenin and EGCG for 
experimental validation. These compounds in this study have a high binding affinity and 
stability, pointing to their potential as therapeutic modulators of TREM2 activity. Overall, the 
present experiment shows that natural phytochemicals can be effective modulators of 
microglial receptors and molecular docking is an effective preliminary screening technique to 
investigate candidate compounds that could modify the course of Alzheimer's Disease. 
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5.1 SUMMARY OF FINDINGS 

The present dissertation has made a systematic computational study of the binding interactions 
between four well characterized natural polyphenols (EGCG), apigenin, curcumin and 
resveratrol) and the extracellular immunoglobulin like domain of TREM2, PDB ID: 5ELI), an 
important microglial receptor that has recently been implicated in disease (AD) as a high-value 
target. The study created a detailed computational map of polyphenol–TREM2 interactions 
using molecular docking conducted via the virtual screening platform PyRx, with AutoDock 
Vina, followed by detailed interaction profiling in BIOVIA Discovery Studio Visualizer, with 
the aim to finding possible lead phytochemical candidates for TREM2-targeted neuroprotective 
therapy. 

Through the docking process, a sequence of binding affinity was found for the four 
polyphenols. Apigenin was the most tightly bound compound with an affinity of −8.6 kcal/mol 
due to the presence of a dense network of such non-covalent interactions as Pi–Cation bonds 
with ARG47 and ARG122, hydrogen bonds with ASN residues and THR residues, and 
favorable hydrophobic Pi–Alkyl contacts with PRO59. The binding affinities of curcumin and 
resveratrol were moderate (−7.1 kcal/mol and −6.3 kcal/mol, respectively), with relatively less 
extensive binding networks, suggesting that the thermodynamic fit of both compounds in the 
TREM2 binding site was not as strong as that of the others under the conditions studied. 

These computational results align with and expand upon the already established preclinical 
evidence, which shows that both apigenin and EGCG can be effective in the anti-
neuroinflammatory and neuroprotective categories. The highly predicted binding of apigenin 
and EGCG to the TREM2 ligand-recognition interface provides a new level of molecular 
evidence for apigenin's and EGCG's reported effects on microglial activation, 
neuroinflammatory cytokine release, and ameliorating effects on amyloid-beta (Aβ) toxicity, 
which are tightly linked to the activities of TREM2 downstream in the context of AD 
pathogenesis. Combined these results are adequate for the first research goal of this thesis, and 
provide a useful computational basis for the nomination of apigenin and EGCG as high-priority 
candidates for TREM2 targeted drug discovery. 

5.2 INTERPRETATION IN THE CONTEXT OF TREM2 BIOLOGY AND AD 
PATHOLOGY 

The biological relevance of the docking results could best be understood within the context of 
TREM2's complex function in microglial physiology during AD progression. The TREM2-
DAP12-PI3K-Akt, TREM2-DAP12-MAPK/ERK, and TREM2-DAP12-mTOR pathways 
drive microglial activation from the homeostatic state to a disease-associated microglial 
(DAM) phenotype, characterized by increased phagocytic capacity, metabolic reprogramming, 
and local containment of amyloid plaques. The high binding affinities at key residues such as 
ARG47, ARG122, which are located at or near the positively charged surface that binds to the 
TREM2 ligands, indicate that apigenin and EGCG may structurally mimic the endogenous 
TREM2 ligands from lipids or phospholipids, which would likely permit or enhance receptor 
activation in a disease context where lipids are dysregulated and Aβ is deposited. 

This mechanistic hypothesis is further corroborated by the pharmacological profile of both the 
lead compounds. Apigenin has been shown to modulate TREM2-regulated neuroinflammatory 
signaling, and to enhance hippocampal neurogenesis, which are all processes downstream of 
or overlapping with microglial activation in the TREM2 pathway. The major bioactive tea 
catechin, EGCG, has been demonstrated to have abilities to inhibit Aβ aggregation, 
disaggregate preformed fibrils, chelate redox-active metal ions, and block multiple pro-
inflammatory signaling axes in microglial and neuronal cell models. In the present study, the 
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additional mechanistic dimension is added that direct engagement of the TREM2 receptor may 
be one of the contributing mechanisms underpinning these broad neuroprotective effects; an 
entirely new and testable hypothesis. 

Given that the binding affinities of curcumin and resveratrol are relatively weak, these 
compounds do not appear to be the primary targets of TREM2 in the brain; the other molecular 
mechanisms they are known to engage are additional targets and mechanisms that likely 
account for their experimentally demonstrated beneficial effects. This subtle interpretation 
highlights the importance of computational prioritisation in prioritising experimental resources 
to the most mechanistically plausible candidates. 

5.3 LIMITATIONS OF THE STUDY 

It is evident that there are some important limitations in the present investigation. Second, the 
molecular docking approach is a static, simplified view of the protein–ligand interaction 
process, which might not reflect the true dynamics of the process in a physiological context, 
and may not include conformational changes induced in the TREM2 receptor by the bound 
ligand. The stability of the predicted and under conditions that better reflect the membrane-
associated, glycosylated microglial environment in which TREM2 normally functions would 
be assessed using molecular dynamics (MD) simulations, which were not undertaken in the 
present study. 

Second, the docking simulation was done for the isolated extracellular immunoglobulin-like 
domain of TREM2 (PDB ID: 5ELI) without the transmembrane part, intracellular tail, and the 
DAP12 adaptor complex. This crystal structure is well understood and suitable for extracellular 
domain docking studies but does not fully capture the quaternary structural context in which 
TREM2 is found at the microglial plasma membrane in the context of the functional TREM2–
DAP12 signaling complex. Finally, the tested polyphenols possess features that pose major 
translation challenges, especially their low aqueous solubility, poor oral bioavailability, and 
first-pass metabolism by hepatic enzymes in the gut, which are not taken into account during 
computational docking. To ensure sufficient in vivo brain exposure, in silico compound binding 
to TREM2 does not necessarily yield compounds with sufficient in vivo properties and may 
need in vivo pharmacokinetic optimization or nanoformulation strategies. 

Last but not least, this present analysis was limited to four representative polyphenols. A more 
comprehensive virtual screening campaign that expands the phytochemical library to include 
other polyphenol semi-synthetic derivatives with better pharmacokinetic properties could 
result in even more candidates that have higher predicted TREM2 affinity and selectivity. 

5.4 FUTURE DIRECTIONS 

Results of this dissertation provide several scientifically promising and tractable avenues for 
further research. To assess the conformational stability, binding free energy and dynamic 
interaction profiles of the top-ranked complex of apigenin–TREM2 and EGCG–TREM2 over 
physiologically relevant timescales, molecular dynamics simulations of these predicted 
complexes should be performed in the immediate future. The binding free energy calculated 
will be useful in addition to the static docking scores and will give a more rigorous 
thermodynamic characterization of these interactions. 

Experimental validation via in vitro biochemical assays should be used to directly measure the 
binding affinities of apigenin and EGCG for the recombinant TREM2 protein and to validate 
the computational predictions. Next, cell-based functional studies in primary microglia 
(michaels) and human iPSC-derived microglia (iMCHs) and TREM2-overexpressing 
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microglial cell lines should be performed to see if apigenin and EGCG treatment are able to 
recapitulate the functional outcomes of TREM2 (such as enhanced Aβ phagocytosis; reduced 
pro-inflammatory cytokine secretion; improved microglia survival under metabolic stress; and 
facilitated DAM transition in the presence of amyloid stimuli). 

The evaluation in well-established transgenic models of AD (e.g., 5xFAD, APP/PS1 or 3xTg-
AD), with outcomes measured as amyloid plaque burden, tau pathology, microglial activation 
state, and cognition in behavioral paradigms, would be a crucial translational step at the 
preclinical level. In addition, formulation approaches like prodrugs, lipid-based drug delivery 
systems, and encapsulation of polyphenols in nanoparticles should be investigated in parallel 
to enhance their BBB penetration and CNS bioavailability to overcome the pharmacokinetic 
limitations. 

The present study can be further expanded in terms of computation by using virtual screening 
of larger natural product library in the binding site of TREM2, and then selecting potential 
modulators. Scaffold optimization by structure–activity relationship (SAR) analysis of 
apigenin and EGCG can further inform the rational design of improved apigenin and EGCG 
with better predicted TREM2 binding and metabolic stability, as well as better drug-likeness. 

5.5 CONCLUDING REMARKS 

Alzheimer's disease is one of the biggest unmet medical needs of the 21st century and the 
continued failure of amyloid-centric monotherapy approaches has highlighted the need for 
urgently identifying and validating new targets for therapeutic intervention that can overcome 
the full mechanistic complexity of disease. One of the emerging targets is TREM2, which 
receives input from microglial sensing, phagocytosis, metabolic adaptation and 
neuroprotection, which are all important processes needed to control and possibly reverse the 
progression of AD pathology. This study is a relevant scientific contribution to this new 
therapeutic frontier, demonstrating the strong and structurally specific predicted interactions of 
the naturally occurring, broadly safe anti-neuroinflammatory and blood–brain barrier 
permeable phytochemicals apigenin and EGCG with the TREM2 ligand-binding domain. 

Although the in silico approach is not necessarily translatable to the clinic until further 
experimental studies are performed, the scientific and strategic rationale outlined in this study 
is relevant as a prioritization approach in the initial stages of drug discovery. In this way, natural 
polyphenols, which are pleiotropic neuroprotective agents, could have an unknown, but newly 
identified mechanism of action by direct modulation of TREM2, a receptor that is located at 
the intersection between neuroinflammation, microglial homeostasis and amyloid clearance in 
disease. 

In conclusion, this dissertation shows that apigenin and EGCG are both computationally 
appealing phytochemicals able to interact with TREM2, and provides a computational basis 
for understanding the structural basis of predicted TREM2 interactions, as well as a solid 
computational platform for their subsequent incorporation into their respective experimental 
validation pipelines for development of effective plant-derived therapeutic strategies to treat  
disease. In doing so, this study adds to the accumulating evidence for the therapeutic 
modulation of microglial TREM2 signaling as a viable and scientifically compelling course of 
action in the battle against this crippling neurodegenerative disease. 
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